
Adobe Photoshop CC  
14.1 update

Welcome to the latest Adobe Photoshop CC bulletin update. 
This is provided free to ensure everyone can be kept up-
to-date with the latest changes that have taken place in 
Photoshop CC. 
	 This bulletin describes the latest changes to the main 
Photoshop program. For a complete description of how to 
use these new Photoshop tools, with diagrams and step-by-
step tools, I recommend you buy the Adobe Photoshop CC 
for Photographers book.
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Performance improvements
Photoshop’s performance has been improved in this release, 
offering better crash prevention when using the GPU through 
improved GPU detection and disabling. There has also been 
improvements to the stability of the content-aware feature.

Generator: generate assets from layers
This new feature uses a customizable JavaScript-based 
platform and can be used to automatically create derivative 
files from the master image you are working on. To get set up 
you’ll first need to go to the Photoshop Plug-ins preferences 
(shown in Figure 1) and check the Enable Generator box. 
	 This launches Generator so it is always running in the 
background. Following that you’ll need to enable Generator for 
each image document you are working on. To do this, select 
File ➯ Generate ➯ Image Assets. This initiates Generator for 
the selected file and the setting remains sticky the next time 
you reopen the image. Once you have followed these steps 
you can use layer naming to determine how derivative files will 
be created.

Figure 1 The Photoshop Plug-ins preferences.

Generator overhead
Enabling Generator does imply some 
additional overhead. However, since 
Generate Assets must be selected on a 
document basis it seems that this only 
applies when it’s active on an open 
document.
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	 Generator uses the layer or layer group naming to 
determine what derivative files are created and, more 
specifically, its attributes: such as the file format used, the 
quality setting and image size. Basically, you define the desired 
file output by the way you name the layers. For example, 
adding a file format suffix, such as .jpg, .png, or .gif, lets you 
indicate the file format you want the derivatives to be saved in.
	 You can specify more precisely how the file is to be saved. 
If you add .png to a layer name, it will (by default) create 
a PNG 32 file. But if you wish, you can specify other PNG 
formats such as: .png8, or .png24. With JPEG you can specify 
the desired image quality setting (from 1–10) by adding a 
number. The default JPEG quality setting is 9, so adding .jpg6 
creates a JPEG file saved using a 6 quality setting. Or, you can 
specify the JPEG quality more precisely as a percentage, such 
as .jpg55% to save a JPEG that uses a 55% quality setting. 
With the .gif tag this saves a basic alpha transparency GIF 
and there are no other options that can be specified using 
Generator.

Extended tagging
Other tags can be used to specify size by adding one of the 
following tags at the beginning of the layer name. To adjust the 
size by percentage type in a percentage scale value, such as 
25% or 33% at the beginning of the layer name. To adjust the 
size to fit within specific dimensions, enter the units like this: 
600 x 400 can be used to specify creating a file that fits within 
a 600 x 400 pixel size (Generator uses pixel values unless 
otherwise specified). So, you would need to add in (for inches), 
cm (for centimeters) and mm (for millimeters). Tags can be 
separated by commas when naming a layer to indicate that 
more than one type of file should be generated (but each 
tag must be properly formatted with a valid file extension). 
For example, naming a layer 20% garden.png, 10in x 8in 
garden.jpg8 will create a 20% scaled PNG, plus a 10 inch x 8 
inch JPEG file saved using a quality 8 setting.
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1 Here is an open image document where in the Plug-ins preferences I had checked 
Enable Generator. With the document open, I went to the File menu and chose 
Generate ➯ Image Assets. I arranged all the layers into a single layer group and 
named this ‘20% Car.jpg7’. The naming used here specified this should create a JPEG 
file resized to 20% the original image’s file size and save using a JPEG quality setting 
of 7.

2 Because Generator was enabled, this automatically created an assets folder 
identified using the file name of the original image. Inside this you can see it had 
generated a reduced size JPEG version of the master image.
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3 I then selected the masked Hue/Saturation layer below and clicked on the eyeball 
in the Layers panel to enable the adjustment. This changed the color of the car 
from green to mauve. There was no need for me to save the image as the change 
automatically updated the JPEG image stored in the accompanying assets folder.

4 To check this was the case, I once again visited the file’s assets folder and saw the 
JPEG version had been updated to show the car with the new, changed color. After 
generating all the relevant assets, I then saved the master file for possible further 
editing at a later time.
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Adobe Edge Reflow CC
Adobe Edge Reflow CC is a new Web tool 
that can be used to create responsive Web 
designs that adapt content to different 
screen sizes. Using Edge Inspect CC. it is 
possible to extract the CSS code from an 
Edge Reflow project to work on in other 
code editors, such as Dreamweaver.

Summary of  how Generator works
Let me summarize what happens in the background when 
using Generator. Whenever you work on a brand new image 
and File ➯ Generate ➯ Image Assets has been activated, 
assets are initially saved to a  generic assets folder on the 
desktop, most likely named: Unitled-1-Assets. Whatever assets 
have been generated will be present in this folder. Once a 
master file has been saved though, an assets folder is created 
alongside the parent file inside whatever folder directory you 
chose to save the file to. This assets folder will use the same 
name as the file it relates to. The original desktop assets folder 
(which was temporary) will then disappear. All subsequent 
edits made to the open image will continue to generate 
updated assets, regardless of whether the master file has 
been saved to update the parent file.

Generator uses
Generator is a feature that should be of interest to a lot of 
different Photoshop users. The preceding example shows a 
simple use of generator in which a low res JPEG version of 
the composite image was created. This would continuously 
get updated as the file was worked on. A practical use for this 
type of workflow would be having instant access to a low res, 
composite version of the image you are working on, ready to 
email to a client.
	 I would say this feature was devised mainly with 
multimedia designers in mind. Using Photoshop CC 14.1 in 
conjunction with the Edge Reflow CC program, designers 
can use Generator to work on a master file in Photoshop and 
generate Web asset files that are automatically updated in 
real-time. I have also read about designers at The Engine Co, 
who used Generator to write a plug-in for their Loom gaming 
engine. This allowed them to update the user interface for a 
game in Photoshop while it was being played. As described 
on page 3, the system is pretty flexible too and can allow 
designers to generate Retina resolution assets to accompany 
regular resolution versions, again, all in real-time.
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Figure 2 The filters highlighted above are now available when editing in 32-bit 
mode. Blur: Blur, Blur More; Distort: Displace, Pinch, Polar Coordinates, Ripple, 
Shear, Spherize, Twirl, Wave, Zig-Zag; Pixelate: Color Halftone, Crystalize, Facet, 
Fragment, Mezzotint, Mosaic, Pointilize; Render: Fibers, Lens Flare; Sharpen: 
Sharpen, Sharpen More; Stylize: Diffuse, Trace Contour; Other: Custom. Note when 
using the Diffuse filter in 32-bit mode, the Anisotropic option is grayed out.

Filters
There are now 24 more filters that work in 32-bit mode.
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Color Range
Color Range improvements offering greater control of 
Highlights, Midtones, and Shadows selections. Now, instead 
of being restricted to the use of ‘hard-coded’ value ranges, the 
exact range of tones and the partial selection of surrounding 
tones can be customized. In the case of the Highlights and 
Shadows selections there is a single slider with which to adjust 
the extent of a highlights or shadows selection. In the case of 
the Midtones you have two sliders at your disposal to fine-tune 
the midtone range.

1 I opened the image shown here in Photoshop, went to the Select menu and 
chose Color Range… To start with I selected the Shadows option from the Select 
menu. Shown here is the default setting, which is the same as the previous, hard-
coded range value used in Color Range. To reset the sliders here to the defaults,  
AS–click on the Reset button.
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2 Using Photoshop CC 14.1 it is now possible to edit the Fuzziness and Range values 
for a Shadows, Midtones or Highlights selection. In this instance I adjusted both 
sliders to fine-tune the shadows selection. With the selection active, I added a Curves 
adjustment layer and applied the lightening curve shown here to lighten the shadows.
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3 I then went to the Select menu again, chose Color Range… and this time selected 
the Midtones option from the Select menu. I then adjusted the Fuzziness and Range 
sliders to fine-tune the Midtones selection. After that I added another new Curves 
Adjustment layer, this time applying a darkening curve to create the final version seen 
here.
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Layer selection
There is a new option in the Option bar for the path selection 
and direct selection tools that allows you to select All Layers/
Active Layers (see Figure 3). The All Layers mode retains the 
original Photoshop CC behavior. However, when Active Layers 
is chosen, the path selection tools will only be able to affect the 
layers that are currently active in the Layers panel. The steps 
shown on the following page help explain this more clearly.

Figure 3 This shows the Options bar for the path selection tool and the new pop-up 
menu offering a choice of All Layers/Active Layers.

Figure 4 If you go to the Edit menu in Photoshop and choose Keyboard 
Shortcuts… this opens the dialog shown here. If you select Shortcuts For: Tools and 
scroll to the bottom of the list you can assign a shortcut to toggle the new All Layers/
Active Layers behavior.

	 Previously in Photoshop CC, when using the path selection 
or direct selection tools you could double-click on a vector path 
as a shortcut to switch to an isolation mode filter view of just 
that layer in the Layers panel. You could then double-click again 
on the path to toggle and revert to a full layer view again. This 
can still be done when you are in All Layers mode, but not, if 
you have Active Layers selected. Flipping between these two 
modes can also be assigned a keyboard shortcut in the Tools 
section at the bottom of the list (see Figure 4).
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1 In this example the All Layers option was selected in the path selection tool Options 
bar. When I marquee dragged across the whole image with the path selection tool all 
the vector path layers became selected and with it also the layers in the Layers panel 
associated with these paths. This was regardless of whatever layer selection might 
have been in place.

2 In this next example, just the three layers at the bottom were made active in the 
Layers panel. I set the path selection tool Options bar to Active Layers mode and 
marquee dragged across the whole image again. This time only the vector paths 
associated with the active layers in the selection made in the Layers panel became 
selected and the Layers panel selection remained unchanged.
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Selecting path anchor points
Refinements have been made to anchor point selection when 
working with the direct selection tool. As can be seen below 
in Figure 5, if you have a path selected with multiple anchor 
points activated, a mouse-click on an anchor point with the 
direct selection tool will make that single anchor selected and 
all the other points deselected. Previously, when you clicked 
with the direct selection tool the anchor point selection would 
be preserved. You can still retain this behavior. Let’s say you 
make a selection of a few anchor points and wish to move 
them. What you do is click and hold with the mouse and drag. 
The anchor point selection will then be preserved. It is just 
when you single-click on an anchor point that it deselects all 
the anchor points.

Figure 5  If you have a path with multiple anchor points active and the direct 
selection tool is selected, if you click on a single anchor point this will be selected and 
all the other points deselected.
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Properties panel
There is a new option in the Properties panel fly-out menu that 
allows you to control showing the panel on shape layer creation. 
I don’t think the Adobe new feature notes make it exactly clear 
what is meant by this. It means, when it is checked (as shown 
below in Figure 6), the Properties panel will open (if it’s hidden) 
whenever you create a new vector shape layer.

PSDX support
There is now native read-only support for the PSDX file format. 
This now makes it easier to read files that have been created 
on a tablet or mobile phone device using Adobe Photoshop 
Touch.

Photoshop/Behance integration
Behance is a networking site for creatives, allowing them to 
share their work and is also integrated with Creative Cloud 
subscriptions. According to the latest Adobe press release, 
Behance  is now available for more languages, but they 
have yet to announce which specific languages have been 
added. For now, we’ll need to wait till Adobe provides more 
information.

Figure 6  When ‘Show on Shape Creation’ is checked in the Properties panel the 
Properties panel will open by default whenever a new shape layer is created.
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Camera Shake Reduction filter
The Shake Reduction filter (which was new to Photoshop 
CC) has been updated to provide retina display support for 
Macintosh users, although all users should notice improved 
performance when working with large displays.
	 There is now a checkbox to disable artifact suppression, 
which can speed things up when working with this filter. Figure 
7 below shows examples of this user interface enhancement.

Figure 7  When using the Camera Shake Reduction filter there is now a checkbox at 
the top of the panel controls that allows you to disable the Artifact Suppression. When 
checked, this hides the Artifact Suppression slider.


